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Overview
The following external parts are needed to demonstrate the design example;

e MAX10 NEEK

e Mini-USB cable for programming the device

e Ethernet cable

e IMPORTANT: only use the 5V adapter that came with this kit. Do not use other power
supplies from other Altera kits, these have higher voltage and may blow out the kit’s power
circuits

Theory of Operation
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Figure 1: Ethernet Reference Design Block Diagram

The Simple Socket Server design uses a modified version of Altera’s Nios' Il Ethernet Standard hardware
design. It provides a mix of peripherals and memories similar to a typical Nios Il processor system. This
design interfaces with each hardware component on the Altera’ development board, such as SDRAM,
LEDs, push buttons, and an Ethernet physical interface or media access control (PHY/MAC). This Qsys-
based hierarchical design has a top-level system and two subsystems, namely: peripherals subsystem
and Ethernet subsystem as shown in Figure 1.



For more details on the Nios Il Simple Socket Server implementation, please refer to page 1-16 on the

following documentation.

Simple Demo Setup
1. Connect an Ethernet cable to the board as shown in the pictures.
2. Connect the power cord to the power plug, and connect a mini USB from your PC/laptop to the

J8 UB2 connector on the top left of the kit.
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3. The design package includes a pre-compiled version of the design that downloads to the MAX 10
embedded flash. This version of the configuration includes the combined FPGA configuration

and NIOS executable. Follow these instructions to load the design onto your kit:
Make sure the board is powered on (push the red power button) and that the USB is

connected on J8

a.
b. Startup Quartus. Then start the programmer from Tools - Programmer.
Click Hardware Setup - USBBlaster Il and select Add Hardware

C.
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d. Click “Auto Detect” and double click where it says <none> on the first row to add your
.sof/.pof file from the master_image folder. Note: A virtual TAP controller (VTAP) may
show in the JTAG chain — this is OK.
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e. Fillin the checkbox for “Program” and select “Start” to begin downloading the design to
the board — your NEEK will start running the design when the process is successful.

f.  You should see LED4 blinking — this indicates that the board is reading to be remotely
controlled.

4. Open the Nios Il terminal by going to Start - Altera - Nios Il EDS = Nios Il Command Shell
5. Enter the following command:

nios2-download —g <file path >/master_image/niosll_simple_socket_server.elf && nios2-terminal

6. If you get a message prompting you to enter a 9 digit number. Enter a potentially correct MAC
address like 255255248. This happens because some boards do not have a MAC address
dedicated in the CFI Flash. The user has to enter the address if this is the case.

7. This will download the software onto the Nios Il processor and run the software. The IP Address,
Subnet Mash, and Gateway information will be set up and displayed. After it loads, the console
should indicate that the Simple Socket Server is “listening on port <port number> as shown

below.
i = =] =

B ' fcygdrve/zfethemet_10M50/m10_rgmii_etherneta_bup/software/niosl_simple_sccket_server_1

JARNING = MAC GrouplB] — Humber of PHY connected is not equal to the number of c|
hannel, Mumber of PHY : 2. Channel : 1

PHYIL[A.B]1 — Checking link...

PHYI[B.B]1 — Link not vet established. restart auto—negotiation...
PHY[B.A]1 — Restart Auto—Megotiation. checking PHY link...

PHYI[A.A] — Auto—Megotiation PASSED

PHY[A.A]1 - Link estabhlished

PHYIL[A.AB]1 — Speed = 18880, Duplex = Full

0K, x=8. CHMD_CONFIG=-0xBEB0AAEBHEA

MAC post—initialization: CHMD_CONFIG=BxB480028h
[tse_sgdma_read_init] RBH descriptor chain desc €1 depth) created
mctest init called

IP address of etl - B.B.8_8

Created "Inet main" task (Prio: 2>

Created "clock tick" task (Prio: 32

foouinad TP addwece adia THCR ~]ljient for interface: etl

IP address : 137.57.237.25

m

LIS - DS M= fofof ol o dandof o EF

Gateway : 137.57.237.254

Simple Socket Server starting up
[zz=s_task] Simple Socket Server liztening on port 38
Created "simple socket server' task (Prio: 4>

8. Open up telnet client in the computer’s command window by typing “telnet” and hitting enter.
9. Once you’ve entered the telnet client, open up the port by entering the command:

open <IP address shown on the Nios terminal> <port number>

BN Administrator Chwindows\system32\cmd.exe - telnet
llelcome to Microsoft Telnet Client

Ezcape Character is ‘CTRL+1

Microsoft Telnet?> open 137.57.237_.25 38




10. Once successfully connected, your screen should show the menu for controlling the board
remotely. Entering a number between 0-3 will toggle LEDs 0-3 respectively.

BN Telnet 137.57.237.25 o B8 X

mi »

B—-3: Toggle bhoard LEDz DB — D3
Q: Terminate i
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Simple Socket Server Command
Simple Socket Server Command
Simple Socket Server Command
Simple Socket Server Command

Simple Socket Server Command

Simple Socket Server Command

How to compile the hardware
Follow the steps on the Design Store web page to extract and install the simple_socket_server_10M50

platform file. The following steps describe how to setup a project in Quartus Il software in order to
program the MAX10 FPGA device with the Simple Socket Server design.

Note - extract platform

i) Launch Quartus Il software and open the project top.qpf using File->Open Project.

ii) Compile the Project by clicking the * button.

iii) Launch the Quartus Il programmer from the Tools menu or alternatively by clicking the v
button.

iv) Download the .sof file output_files/top.sof and program the device using the programmer

as previously described.



How to compile the software

The following steps describe how to use Nios Il Software Build Tools for Eclipse software to perform the
following tasks;

i) Create a software project (BSP and application) from a .sopcinfo file
ii) Add source code to the project
iii) Download and run source code on the target processor (NIOS II)

1. Open Quartus Il on a windows platform
Launch Nios Il Software Build Tools for Eclipse from the Tools menu
Specify the workspace directory for the project and click ok.

Workspace Launcher <@sj-iccf0127> x

Select a workspace

Eclipse stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session.

Workspace: |/data/acastill/simple_socket 10M50/software ‘ w7 l [

[[] Use this as the default and do not ask again

Cancel l [ OK ]

4. A blank workspace window pops up, right click anywhere in the Project Explorer and select the
following to create a new software project; New->Nios Il Application and BSP (board support
package) from Template.

5. Inthe window that appears, browse to the location of the .sopcinfo file in the project folder and
add it to the project. Provide a name for the software project i.e. niosll_simple_socket_server
and select “Simple Socket Server” for your template. Click Finish.



| Nios Il Application and BSP from Template <@sj-iccf0127> o X

Nios Il Software Examples

Create a new application and board support package based on a software example
template

Target hardware information

SOPC Information File name: [!data!acastiII!simple_socket_10M50!q_5ys.sopcinfc] E]

CPU name: [cpu -

Application project

Project name: | nigs) simple_socket_server

Use default location

Project location:

Project template

Templates Template description
Hello World (4] Simple Socket Server uses the industry standard <]
Sockets interface to TCP/IP. This application shows
Hello World Small how to initialize the NicheStack TCPAP Stack and
Memory Test run a simple TCP server application, allowing a PC  ||—
| to communicate with a Nios Il system via

Memory Test Small Ethernet.
Simple Socket Server

) || [This example requires the MicroC/OS-Il RTOS and
Simple Socket Server (fl~] njchestack TCPAP Stack - Nios Il Edition software ||
[ | | |'] comnnnents It alsn rennires several nerinherals )

@ Next > ] l Cancel l [ Einish

A BSP is created and located at niosll_simple_socket_server and an application is created and
located at niosll_simple_socket_server_bsp.
The application contains source code from the template design “Simple Socket Server” that
needs to be replaced with the source code located in the software/src folder. Select all the .c
and .h files under the main project explorer tab. Right click and delete.
Right click the project name and left click the import command. We will be importing source
code that has been modified for this dev kit.
Navigate to General - File System

a. Browse to the location of src, click on the box next to it, add it as shown and click Finish.



Import resources from the local file system into an existing project.

-
= Import
= Nios [ - Eclipse Select
File Edit MNavigate Sf
e || =
Select an import source:
3 type filter text
[ Project Explorer 53 J =
= 4 [= General
5| [ Archive File
4 125 niosMAX10EvalB]|
> [al Includes [, File System
4 [z s _ El Preferences
= devices s B C/C++
= drivers e L

=% Existing Projects into Workspace

10. Import the contents of the src folder as shown below

-

=

]

[ Project Explorer &2 B &
= 1% niosll_simple_socket_server

b 4¥ Binaries

b ilincludes

P = obj

b [ alt_error_handler.c

b [ alt_error_handler.h

b [ iniche_init.c

b [Fled.c

b [ network_utilities.c

b [ network_utilities h

b [ simple_socket_server.c

b [if simple_socket_serverh

b [ tse_my_system.c

3 ﬁ&niosll_simple_socket_server.elf - [alteranios2/le]

B Makefile

P £ niosll_simple_socket_server_bsp [q_sys]

|=| create-this-app

|=] niosll_simple_socket_servermap

|=] niosll_simple_socket_server.objdump

[Z] readme txt

n outline is not
ailable.

j € Import <@sj-iccf0127> 0%

File system

—

Import resources from the local file system Iﬂ;
From directory: |/data/acastill/simple_socket_10M50/src ‘ = l [ Browse ]
& src alt_error_handler.c
[g alt_error_handler.h
€l iniche_init.c
cl led.c
network_utilities.c
network_utilities_h
simple_socket_serverc -
Iﬁ\ter Iypes ] l Select All l [ Deselect All
Into folder: [n|us\Iiswmplsisocketiserver ] [ Browse...

Options

[ Overwrite existing resources without warning

[] Create top-level folder

®

Your project directory on the left should look similar (mem_init and the .elf will be created later)

11.
12.

13.

14.

Compile the project by selecting Build All from the Projects Menu or alternatively Ctrl+B.
Program the FPGA device by launching Quartus Il programmer from the menu and loading the
file output_files/top.sof.

Load the executable to the processor by right clicking on the Application project and selecting
Run-As Nios Il Hardware.

In the Run Configurations page under the Target connections tab. Check the options; Ignore

mismatched system ID and Ignore mismatched system timestamp. If you don’t see the
connection specified, click Refresh Connections. Click Apply followed by Run.



* | Run Configurations <@sj-iccf0127>
Create, manage, and run configurations

The expected Stdout device name does not match the selected target byte stream device name.

>

0B =% B 3 - Name: [mnsll_simple_sccket_server Nios Il Hardware configuration l
| | Project |k Target Connection - 3% Debuggeﬂ By Source] =] gummurﬂ
C/C++ Application CenrGiEms =
- FOCESSOrs]
C/C++ Remote Application Cable [ Device [ Devicein [ instanceip [ mame | architecture | Refresh Connections
# Launch Group USE-BlasterIl on SI-ACASTL...|LOMSODA[...|L o [nios2 0 INios2:3 TP
——

- m Nios Il Hardware

H Cable | Dewvice | Device D | Instance |0 | Mame | Wersion
a1 Nios Il Hardware v2 (beta) USB-BlasterIl on 51-ACASTL...|LOMSODA[... |1 o [fraguart_o 1

(B8 Nios Il ModelSim

[ Nios Il ModelSim v2 (beta) [] Disable 'Mios 1| Console’ view

+¥ SystemTap Guartus Project File name:|< Using default .sopcinfo & jdi files extracted from ELF =

lgrore mismatched system (D)

lgnore mismatched system timestamp

System ID Properties
@ niosll_simple_socket_server Byte Stream Dewices:

[{]

[ I \ D]

Appl
Filter matched 9 of 9 items [ PRIy

@ [ Close

15. If you get the following window, enter a 9 digit number MAC address that makes sense for the
board. For example, if you type 123456789 it won’t work as that is not a potential MAC address.

But if you type in 255255248, it will work as that can be a potential MAC address.

[Z Problems 2] Tasks [E] Console P Nios T Console 53 | £ Properties @ =

simple_socket Mios IT Hardware configuration - cable: USB-BlasterIl on localhost [USE-1] device ID: 1instance ID: 0 name: jtaguart_0

InterNiche Portable TCR/IE, v3.1

Copyright 1996-2008 by InterNiche Technologies. All rights reserved.
prep tse_mac 0

Can't read the MAC address from your board (this probably means
that your flash was erased). We will assign you a MAC address and
atatic network settings

Please enter your 9-digit serial number. This is printed on a
lakel under your Niocs dev. board. The firat 3 digits of the
label are A57 and the serial number follows this.

—->Created "Inet main™ task (Prio: 2)

Created "clock tick™ task (Prio: 3)

This happens because on some boards there is no MAC address in the CFl flash dedicated

section. In such cases, the software is designed to wait for the user to manually type
address.

in the MAC




16. Now your hardware image is downloaded to the FPGA through the Quartus programmer and

the NIOS code has also been downloaded through Eclipse and will automatically start running.
Refer to the Nios Il console on Eclipse:

[2. Problems i Tasks E Console #Nios Il Console & [ Properties & ¥ = O
niosll_simple_socket_server Nios |l Hardware configuration - cable; USE-Blasterll on 3)-ACASTILL-947 [USE-1] device ID: 1 instance ID: 0 name: jtaguart_0

INFO : PHY[0.0] - Restart Auto-Wegotiation, checking PHY Tink... -
INFO : PHY[0.0] - Auto-Negotiation PASSED

INFO : PHY[0.0] - Link estahlished

INFO @ PHY[0.0] - Speed = 1000, Duplex = Full

Ok, x=0, CHD_CONFIG=0x00000000

MAC post-initialization: CHMD_CONFIG=0x0400020h0
[tse_sgdna_read_init] R} descriptor chain desc (1 depth) created
mETesT iniT called

IP address of etl @ 0.0.0.0

Created "Inet main" task (Prio: 23

Created "clock Tick" task (Prio: 33

acquired IP address via DHCP client Tor interface: etl

IP address @ 137.57.237.25

Subnet Mask: 255.255.255.0

Gateway : 137.57.237.254

Simple Socket Server sTarting up
[s55_task] Simple Socker Server 1istening on port 30
Created "sinple socket server" task (Prio: 4)

17. You can proceed to the demonstration as discussed in the earlier steps. The method described

works well if you are modifying your code. You can maintain the same FPGA download and
iterate through code revisions.



